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QUESTION 1

You work as an Office Assistant for Media Perfect Inc. You have created a spreadsheet in Excel 2013 and shared it with
the other employees of the company. You want to select password protection and select options to prevent other
employees from changing, moving, and deleting important data. 

Which of the following options will you choose to accomplish the task? 

A. Mark as Final 

B. Protect Current Sheet 

C. Encrypt with Password 

D. Protect Workbook Structure 

Correct Answer: D 

The various Protect Workbook options are as follows: 

1.

 Mark as Final: This option is used to make the document read-only. When a spreadsheet is marked as final, various
options such as typing, editing commands, and proofing marks are disabled or turned off and the spreadsheet becomes 

read-only. This command helps a user to communicate that he is sharing a completed version of a spreadsheet. This
command also prevents reviewers or readers from making inadvertent modifications to the spreadsheet. 

2.

 Encrypt with Password: When a user selects the Encrypt with Password option, the Encrypt Document dialog box
appears. In the Password box, it is required to specify a password. Microsoft is not able to retrieve lost or forgotten 

passwords, so it is necessary for a user to keep a list of passwords and corresponding file names in a safe place. 

3.

 Protect Current Sheet: This option is used to select password protection and permit or prohibit 

other users to select, format, insert, delete, sort, or edit areas of the spreadsheet. This option 

protects the worksheet and locked cells. 

4.

 Protect Workbook Structure: This option is used to select password protection and select options to prevent users from
changing, moving, and deleting important data. This feature enables a user to protect the structure of the worksheet. 

5.

 Restrict Permission by People: This option works on the basis of Window Rights Management to restrict permissions. A
user is required to use a Windows Live ID or a Microsoft Windows account to restrict permissions. These permissions 

can be applied via a template that is used by the organization in which the user is working. These permissions can also
be added by clicking Restrict Access. 
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6.

 Add a Digital Signature: This option is used to add a visible or invisible digital signature. 

It 

authenticates digital information such as documents, e-mail messages, and macros by using computer cryptography.
These signatures are created by specifying a signature or by using an image of a signature for establishing authenticity, 

integrity, and non-repudiation. 

 

QUESTION 2

You work as an Office Assistant for Blue well Inc. The company has a Windows-based network. You are creating a hot
spot on a graphic that other users can click to run a macro. Which of the following steps will you take to accomplish the
task? 

Each correct answer represents a part of the solution. Choose all that apply. 

A. To assign an existing macro to the graphic object, double-click the macro or enter its name in The Macro name box. 

B. Click the arrow next to Shape Outline, and then click No Outline. C. Right-click the created hot spot, and then click
Assign Macro. 

C. To create a hot spot on the existing object, on the Insert tab, in the Illustrations group, Click Shapes, select the shape
that you want to use, and then draw that shape on the existing object. 

D. Click the name of the macro in the Macro name box, click Edit, and then click OK to edit an existing macro. 

E. Click the arrow next to Shape Fill, and then click No Fill on the Format tab. 

F. Click Record, type a name for the macro in the Record Macro dialog box, and then click OK to start the recording of
the macro. 

G. Select the hot spot in the worksheet to display Drawing Tools for adding the Format tab. 

H. Click Slicer, type a name for the macro in the Slicer Macro dialog box, and then click OK to start the recording of the
macro. 

Correct Answer: ABCDEFGH 

 

 

QUESTION 3

You work as an Office Assistant for Blue Well Inc. The company has a Windows-based network. You have changed
some data in the worksheet of the company. You are submitting the sell workbook of the company to the Administrator
of the company for comments. Now, you want to merge input that you receive into a copy of that workbook, including
the changes and comments that you want to keep. For this purpose, it is required to access and use the stored change
history. Which of the following will you use to accomplish the task? 

A. Slicer-enabled highlighting 
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B. Onscreen highlighting 

C. Reviewing of changes 

D. History tracking 

Correct Answer: C 

The following ways are provided by Excel to access and use the stored change history: 

1.

 Onscreen highlighting: It is used when a workbook does not contain many changes and a user wants to see all
changes at a glance. 

2.

 History tracking: It is used when a workbook has many changes and a user wants to investigate what occurred in a
series of changes. 

3.

 Reviewing of changes: It is used when a user is evaluating comments from other users. Answer option A is incorrect.
This is an invalid answer option. 

 

QUESTION 4

Rick works as an Office Assistant for Tech Perfect Inc. He is creating a user form through 

Microsoft Excel 2013. While creating forms for a number of users, he is required to repeat some of the actions multiple
times. It is a very time consuming process. To resolve this issue, he wants to record the sequence of actions to perform
a certain task and to play them back in the same order. 

Which of the following actions will Rick take to accomplish the task? 

A. He will use the Trust Center bar. 

B. He will use the Evaluate Formula tool. 

C. He will put the workbook in a trusted location. 

D. He will create and run a macro. 

Correct Answer: D 

A macro is defined as a tool that permits a user to automate tasks and add several functionalities to forms, reports, and
controls. For example, if a user adds a command button to a form, he associates the button\\'s OnClick event to a
macro, 

and the macro consists of the commands that are to be performed by the button each time it is clicked. The macro
records the user\\'s mouse clicks and keystrokes while he works and lets him play them back later. The macro can be
used to 

record the sequence of commands that the user uses to perform a certain task. When the user runs the macro, it plays
those exact commands back in the same order. 
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Answer option B is incorrect. Evaluate Formula is a formula examination tool provided by Microsoft Excel. This tool is
useful for examining formulas that do not produce any error but are not generating the expected result. 

Answer options A and C are incorrect. The benefit of connecting to external data from Microsoft Excel is that a user can
automatically update Excel workbooks from the real data source wheneverthe data source is updated with new 

information. It is possible that the external data connection might be disabled on the computer. For connecting to the
data source whenever a workbook is opened, it is required to enable data connections by using the Trust Center bar or
by 

putting the workbook in a trusted location. 

 

QUESTION 5

You work as a Finance Manager for Blue Well Inc. The company has a Windows-based network. You are using Excel
spreadsheet for maintaining the financial budget and other financial calculations. You want to return the price per $100
face value of a security that pays interest at maturity. Which of the following financial functions will you use to
accomplish the task? 

A. PRICE function 

B. PPMT function 

C. PRICEMAT function 

D. PRICEDISC function 

Correct Answer: C 

Various financial functions (reference) are as follows: 

1.

 ACCRINT function: It is used to return the accrued interest for a security that pays periodic interest. 

2.

 ACCRINTM function: It is used to return the accrued interest for a security that pays interest at maturity. 

3.

 AMORDEGRC function: It is used to return the depreciation for each accounting period by using a depreciation
coefficient. 

4.

 COUPDAYBS function: It is used to return the number of days from the beginning of the coupon period to the
settlement date. 

5.

 AMORLINC function: It is used to return the depreciation for each accounting period. 

6.

77-427 PDF Dumps | 77-427 VCE Dumps | 77-427 Practice Test                              5 / 10

https://www.pass4itsure.com/77-427.html
https://www.pass4itsure.com/77-427.html
https://www.pass4itsure.com/77-427.html


https://www.pass4itsure.com/77-427.html
2023 Latest pass4itsure 77-427 PDF and VCE dumps Download

 COUPDAYS function: It is used to return the number of days in the coupon period containing the settlement date. 

7.

 COUPDAYSNC function: It is used to return the number of days from the settlement date to the next coupon date. 

8.

 COUPNCD function: It is used to return the next coupon date after the settlement date. 

9.

 COUPNUM function: It is used to return the number of coupons payable between the settlement date and maturity
date. 

10.

 COUPPCD function: It is used to return the previous coupon date before the settlement date. 

11.

 CUMIPMT function: It is used to return the cumulative interest paid between two periods. 

12.

 CUMPRINC function: It is used to return the cumulative principal paid on a loan between two periods. 

13.

 DB function: It is used to return the depreciation of an asset for a specified period by using the fixed-declining balance
method. 

14.

 DDB function: It is used to return the depreciation of an asset for a particular period by using the double-declining
balance method. 

15.

 DISC function: It is used to return the discount rate for a security. 

16.

 DOLLARDE function: It is used to convert a dollar price that is expressed as a fraction into a dollar price that is
expressed as a decimal number. 

17.

 DOLLARFR function: It is used to convert a dollar price that is expressed as a decimal number intoa dollar price that is
expressed as a fraction. 

18.

 DURATION function: It is used to return the annual duration of a security with periodic interest payments. 

19.
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 EFFECT function: It is used to return the effective annual interest rate. 

20.

 FV function: It is used to return the future value of an investment. 

21.

 FVSCHEDULE function: It is used to return the future value of a starting principal after applying a series of compound
interest rates. 

22.

 INTRATE function: It is used to return the interest rate for a fully invested security. 

23.

 IPMT function: It is used to return the interest payment for an investment for a specified period. 

24.

 IRR function: It is used to return the internal rate of return for a series of cash flows. 

25.

 ISPMT function: It is used to calculate the interest paid during a particular period of an investment. 

26.

 MDURATION function: It is used to return the Macauley modified duration for a security with an assumed par value of
$100. 

27.

 MIRR function: It is used to return the internal rate of return in which positive and negative cash flows are financed at
different rates. 

28.

 NOMINAL function: It is used to return the annual nominal interest rate. 

29.

 NPER function: It is used to return the number of periods for an investment. 

30.

 NPV function: It is used to return the net present value of an investment on the basis of a series of periodic cash flows
and a discount rate. 

31.

 ODDFPRICE function: It is used to return the price per $100 face value of a security with an odd first period. 

32.

 ODDFYIELD function: It is used to return the yield of a security with an odd first period. 
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33.

 ODDLPRICE function: It is used to return the price per $100 face value of a security with an odd last period. 

34.

 ODDLYIELD function: It is used to return the yield of a security with an odd last period. 

35.

 PMT function: It is used to return the periodic payment for an annuity. 

36.

 PPMT function: It is used to return the payment on the principal for an investment for a particular defined period. 

37.

 PRICE function: It is used to return the price per $100 face value of a security that pays periodic interest. 

38.

 PRICEDISC function: It is used to return the price per $100 face value of a discounted security. 

39.

 PRICEMAT function: It is used to return the price per $100 face value of a security that pays interest at maturity. 

40.

 PV function: It is used to return the current value of an investment. 

41.

 RATE function: It is use d to return the interest rate per period of an annuity. 

42.

 RECEIVED function: It is used to return the amount received at maturity for a fully invested security. 

43.

 SLN function: It is used to return the straight-line depreciation of an asset for one period. 

44.

 SYD function: It is used to return the sum-of-years\\' digits depreciation of an asset for a particular period. 

45.

 TBILLEQ function: It is used to return the bond-equivalent yield for a Treasury bill. 

46.

 TBILLPRICE function: It is used to return the price per $100 face value for a Treasury bill. 

47.
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 TBILLYIELD function: It is used to return the yield for a Treasury bill. 

48.

 VDB function: It is used to return the depreciation of an asset for a specified or partial period by using a declining
balance method. 

49.

 XIRR function: It is used to return the internal rate of return for a schedule of cash flows that is not necessarily periodic. 

50.

 XNPV function: It is used to return the net present value for a schedule of cash flows that is not necessarily periodic. 

51.

 YIELD function: It is used to return the yield on a security that pays periodic interest. 

52.

 YIELDDISC function: It is used to return the annual yield for a discounted security. 

53.

 YIELDMAT function: It is used to return the annual yield of a security that pays interest at maturity. 
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